Greenside Primary School
Art and Design Progression Framework

Curriculum Intent

Community Resilience - Aspiration -

The art curriculum at Greenside aims for children to develop:
¢ The ability to use visual language skilfully and convincingly (for example, line, shape, pattern, colour, texture, form) to express emotions, interpret observations,
e convey insights and accentuate their individuality.
e The ability to communicate fluently in visual and tactile form.
¢ The ability to draw confidently and adventurously from observation, memory and imagination.
e The ability to explore and invent marks, develop and deconstruct ideas and communicate perceptively and powerfully through purposeful drawingin 2D, 3D or
e digital media.
e Animpressive knowledge and understanding of other artists, craft makers and designers.
e The ability to think and act like creative practitioners by using their knowledge and understanding to inform, inspire and interpret ideas, observations and feelings.
¢ Independence, initiative and originality which they can use to develop their creativity.
¢ The ability to select and use materials, processes and techniques skilfully and inventively to realise intentions and capitalise on the unexpected.
e The ability to reflect on, analyse and critically evaluate their own work and that of others.
e A passion for and a commitment to the subject.

Implementation

The Art curriculum at Greenside Primary school has been carefully considered to ensure coverage of all the national curriculum objectives whilst linking back to our locality and school context. As a one a half form entry schooal,
we have carefully devised a 2-year cycle to ensure coverage of key substantive knowledge. The aim is that over the 2 years, pupils will gain a deeper knowledge of the disciplinary skills they need as Artists.

All Art units have a corresponding medium-term plan, which maps substantive knowledge, disciplinary skills and vocabulary on a lesson-by-lesson basis to ensure progression throughout each unit. Each unit has clear end points
mapped and which knowledge we want children to be able to recall and retain.

Each lesson within the sequence will focus on a particular learning ‘lense’ or key concept. These concepts run through school and enable children and staff to relate back to the conceptual knowledge from previous learning.
These ‘lenses’ are then mapped and revisited at regular intervals.
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In order for children to know more and remember more in each area of Art studied, the lesson sequence is structured so that prior learning is considered and opportunities for revision and retrieval of key skills and techniques

are built into lessons through the ‘Fab 5" activities. The Fab 5 is a 5-minute retrieval task that takes place at the start of lessons that often revisit the key substantive knowledge from previous learning in the sequence, year or
from another phase completely.

Through these lessons, we intend to inspire pupils and practitioners to develop a love of Art and see how it has shaped the world they live in. Each unit has a designated ‘end point’ and summaries of the children’s learning will be
evident from the work they have produced throughout the unit, which is revisited regularly. These form the basis of our assessment.

The essential knowledge, highlighted in yellow, has been identified for each unit learning and forms the focus of teacher assessment.




The Art and Design Curriculum and Provision for Pupils with SEND

At Greenside Primary School, we believe all pupils should have the opportunity to learn to the best of their capabilities through a broad and balanced, inclusive curriculum. For our pupils with a Special Educational Need, we
scaffold their learning to provide them with the strongest opportunities for success in our school. We believe firmly in the SEND Code of Practice's statement that 'every teacher is a teacher of SEN' and that our pupils with SEN
should be provided with the same opportunities as their peers in our school. This means that, with their learning being personalised to meet their areas of need, they feel included in the classroom and make progress year on year.
Reasonable adjustments are made in all lessons to enable this.

The Art and Design curriculum can be adapted to meet the needs of children with SEND in the following ways:

Universal Support across school for all subjects

Word Banks for pre-learning and to support during topics and themes

Cutting and Sticking Key Words on to work as prompts

Print out portions of work and learning objectives to minimise writing

Coloured Paper or recycled paper to minimise visual stress & background colours of the whiteboard is considered for pupils with dyslexia.
Breaking down lessons into short, manageable chunks

Mixed ability groups — using peers as support and role models

Adult assistance nearby/ Using another student as a reader/support

Now/Next or Visual Timetables — class and individual/ My Turn/Your Turn

Knowledge map/Mind Maps

Printing work larger and in smaller chunks

Cloze passages/activities to check learning

Draw answers or explanations / Actions — telling the story of a lesson

Fidget toys available/ Cushions for seats — wobble and wedge cushions/ access to standing desks

Pupils with hearing impairments/visual impairments are positioned close to the whiteboard to be able to access.
Word lists of key vocabulary for pre-learning and as prompts

A safe/quiet space in or Cloud Room

Keeping instructions short and one at a time

Universal Support specific to subject
Use systems such as racks so that items such as pencils and scissors can be found and put away in the right place easily.
Targets made clear for lessons and learning — linked to IPM
Make tasks accessible through pupils using, where appropriate: ‘Specialist equipment, e.g. specialist scissors and cutting tools’ generic aids, frames or adhesives to hold down pupils” work to surfaces.
Provide a range of drawing aids such as grids, templates, and viewfinders for transcription.
Pre-teach vocabulary linked to Art that will help the child to succeed in the lesson like shading, drawing, exploring and collage
Pencil grippers — variety of pens and pencils
View sketchbooks at the beginning or end of a project to review pupils’ learning and remind them of their starting points.
Encourage pupils to become aware of their own and others’ work by describing what they think and feel about their own work, and the work of artists, craftspeople and designers.

When planning for Art and Design, class teachers should adapt their lessons where necessary using ideas taken from this list, however, it is important to remember this list is not exhaustive and other adaptations may be needed
for children with specific needs.

We also have ‘Continuum of Provision Maps’ for each area of SEND need (e.g. Autism, Cognitive, SEMH, Visual impairment etc).



Breadth of Study

Key Concepts

EYFS

KS1

KS2

Think about (plan) something to make, have a go at creating,
share your creation with someone else.

72 72
LS X4

Use experiences and ideas as the inspiration for artwork.

Share ideas using drawing, painting and sculpture.

Use experiences, other subjects across the curriculum and
ideas as inspiration for artwork.

Develop and share ideas in a sketchbook and in finished
products.

‘Have a go’ at a range of techniques including, rubbing,
drawing, printing, sculpture, joining and cutting.

72
L4

Explore a variety of techniques.

Improve mastery of techniques.

Take inspiration from the

View and respond to a variety of artwork of different types.

72
L4

Learn about the work of a range of artists, artisans and

Learn about the great artists, architects and designers in

Greats designers. history.
Long Term Plans
EYFS KS1 LKS2 UKS2
Autumn Leaf Pictures Drawing — Portrait Art of Florence Nightingale Pastels — Cave Paintings Drawing and Sculpture — Architecture Study
» Process » Visual Language Famous Arist (International/Diverse Artist): Zaha Hadid

» Colour Theory

Christmas/Hannukah/Diwali/
Thanksgiving cards

» Visual Language

» Media & Materials

Arctic Watercolour Washes
> Process
» Techniques

Beatrix Potter Watercolour Paintings
Visual Language

Media and Materials
Techniques

Artists and Artisans

YV VY

Emotions
Techniques
Artists & Artisans
Styles & Periods

YV VYV

» Media & Materials
> Effects
> Styles & Periods

Printing — Mountain scenes

> Process
» Media and Materials
> Artists & Artisans

Drawing — Art of Anatomy

Colour Theory
Styles & Periods
Artists & Artisans

YVVVVY

Sculpture: Playground

> Process
» Media & Materials

> Effects
> Artists & Artisans

Drawing — Charcoal Iron Man Portraits
Local Artist: Chris Mould

» Visual Language

» Techniques

» Artists and Artisans

Sculpture — Landscape & Nature » Process » Visual Language
» Techniques » Techniques
< » Process > Effects > Effects
w . .
O - Me.dla & Ma.terlals Sketching — Sketches of Lotherton Hall Collage — UK Landscapes
> » Artists & Artisans
(&) » Process » Process
Collage — Sparks and flame Multimedia Project » Techniques » Media and Materials
» Visual Language > Effects > Effects
> Effects .. . ..
British Artist Study — Hockney Digital Art
» Media & Materials y LAL
» Process
» Techniques
> Effects
» Artists & Artisans
Painting - Seascapes Painting — Watercolour Drawing - The Arrival (use of HB pencils/biros to sketch)
Local Artist: Lucy Young Famous Artist (International): Margret Godfrey : -
. Local Artist: Georgia Brooks
» Visual Language » Process i
) ) » Emotions
» Techniques » Techniques .
> Artists & Arti > Colour Th » Techniques
FHsts rsans © _our eory- > Artists & Artisans
i - » Artists and Artisans
Printing — Aboriginal Art I . .
Painting Acrylic Paints on Canvas
— Collage — Pop Art Famous Artist (National): David Hockney
o0
» Visual Language
% Process » Emotions > o guas .
> Techniques > Techniques Media and Materials
O » Colour Theory
>

Artists & Artisans

Clay sculpture — Ancient Greek Tiles
» Process
» Techniques
» Styles and Periods




Key: Essential Knowledge identified for each unit of learning.

Progression of Art & Design Knowledge & Vocabulary

Famous Artist focus (national or international)
Local Artist focus.

EYFS Knowledge and Vocab Summary

Autumn Leaf pictures (colour mixing)

Christmas/Thanksgiving/Hannukah/Diwali Cards

Arctic pictures (watercolour washes)

Beatrix Potter watercolour paintings

Safely use and explore a variety of materials, tools and
techniques, experimenting with colour, design, texture,
form and function.

Safely use and explore a variety of materials, tools and
techniques, experimenting with colour, design, texture,
form and function.

Safely use and explore a variety of materials, tools and
techniques, experimenting with colour, design, texture,
form and function.

Safely use and explore a variety of materials, tools and
techniques, experimenting with colour, design, texture,
form and function.

g ¢ Share their creations, explaining the process they have ¢ Share their creations, explaining the process they have ¢ Share their creations, explaining the process they ¢ Share their creations, explaining the process they
used. used. have used. have used.
¢ Make use of props and materials when role playing e Make use of props and materials when role playing ¢ Make use of props and materials when role playing ¢ Make use of props and materials when role playing
characters in narratives and stories. characters in narratives and stories. characters in narratives and stories. characters in narratives and stories.
@ » Process » Visual Language » Process ’ V|su§l Language .
9 : i i » Media and Materials
c » Colour Theory » Media & Materials » Techniques - .
] » Techniques
» Artists and Artisans
e | know that colours can be mixed to make new colours. e | know that cards can be made and given to people e | know that there are different types of paint. e | know that there are different types of paint
o e | know that | need to mix specific colours in different to celebrate an event. e | know that | need to add water to watercolour e | know that | need to add water to watercolour
';: amounts to create a desired secondary colour. e | know that card can be folded to create a greetings paints. paints.
= e | know how to follow a simple colour mixing chart. card. e | know that | need to wash my brush after each e | know that Beatrix Potter used watercolour paints
é e | know that | can use my finger to paint with. ¢ | know that the design of a greetings card reflects colour. to illustrate her work.
o which event is occurring. e | know that watercolours can be used to create a e | know what an illustrator does.
= e | know that designs can be made using pens, pencils, background, this is called a wash. e | know that | can outline a drawing before adding
g crayons, paint, cutting and joining techniques. watercolour paints.
§ e | know that | can paint with my hands, fingers, e | know that a thin paintbrush should be used for

sponges and brushes.

small areas and a thick brush should be used for
larger areas.

Disciplinary Knowledge (Skills)

| can mix colours.

| can access my own paint using the pump bottles.
| can use a palette.

| can fingerpaint.

e | can fold card.

e | canadd an eye-catching design to a card.

e | can add glitter/sequins/stickers and glitter glue to
enhance my design.

e | can use a template to give me design ideas.

e | can use a brush to do long strokes the length of
the paper.

e | can blend colours using a brush.

e | can identify some colours from the Artic sky
(northern lights)

| can select an appropriate brush.

| can recreate simple watercolour paintings.
| can outline an image.

| can take inspiration from Beatrix Potter.

Vocabulary

Primary, secondary, paint, poster paint, palette, fingerpaint

Card, paper, felt tip pens, pencils, crayons, design,
Hannukah, Christmas, Diwali, thanksgiving, template,

Wash, watercolours, background, blend, mix, straight
strokes.

Watercolour, paint, shades of colours, sketch, thickness,
brushes, features, outline.




KS1 Knowledge and Vocab Summary

Drawing — Portrait Art: Florence
Nightingale in style of Paul Klee

Sculpture: Andy Goldworthy —
Landscape & Nature

Collage: Sparks and flame -
multimedia project

Painting: Seascapes

Printing: Aboriginal Art

Sculpture: Playground

e to use drawing, painting and
sculpture to develop and share their
ideas, experiences and imagination

e to develop a wide range of art and
design techniques in using colour,
pattern, texture, line, shape, form
and space

e to use a range of materials creatively
to design and make products

e to use drawing, painting and
sculpture to develop and share their
ideas, experiences and imagination

e about the work of a range of artists,
craft makers and designers,

e to use a range of materials creatively
to design and make products

¢ to use drawing, painting and
sculpture to develop and share their
ideas, experiences and imagination

¢ to develop a wide range of art and
design techniques in using colour,

e to use a range of materials creatively
to design and make products

¢ to use drawing, painting and
sculpture to develop and share their
ideas, experiences and imagination

¢ to develop a wide range of art and
design techniques in using colour,

e to use a range of materials creatively
to design and make products

e to use drawing, painting and
sculpture to develop and share their
ideas, experiences and imagination

¢ to develop a wide range of art and
design techniques in using colour,

e to use a range of materials creatively
to design and make products

e to use drawing, painting and
sculpture to develop and share their
ideas, experiences and imagination

e to develop a wide range of art and
design techniques in using colour,

‘2’ e about the work of a range of artists, describing the differences and pattern, texture, line, shape, form pattern, texture, line, shape, form pattern, texture, line, shape, form pattern, texture, line, shape, form
craft makers and designers, similarities between different and space and space and space and space
describing the differences and practices and disciplines, and making | e about the work of a range of artists, |e about the work of a range of artists, |e about the work of a range of artists, |e about the work of a range of artists,
similarities between different links to their own work. craft makers and designers, craft makers and designers, craft makers and designers, craft makers and designers,
practices and disciplines, and making describing the differences and describing the differences and describing the differences and describing the differences and
links to their own work. similarities between different similarities between different similarities between different similarities between different
practices and disciplines, and making | practices and disciplines, and making | practices and disciplines, and making | practices and disciplines, and making
links to their own work. links to their own work. links to their own work. links to their own work.
: z : : Famous Artist (International/Diverse
Famous Artist (International): Paul Famous Artist (National): Andy . . . ( . / A
Local Artist: Lucy Young Artist): Clifford Possum Tjapaltjarri
Klee Goldworthy . .
«n . » Visual Language » Visual Language » Process » Process
9 » Emotions » Process . N . . .
c . . ) > Effects » Techniques » Techniques » Media & Materials
Q » Techniques » Media & Materials . . . .
- . . . . » Media & Materials » Artists & Artisans » Colour Theory
» Artists & Artisans » Artists & Artisans .
> Stvles & Periods » Styles & Periods
> . . .
y > Artists & Artisans
3
£ | Portrait of Florence Nightingale in the . Black background with sillohette chalk Textured painting composition. A print in the style of Clifford Possum .
= Large landscape Art — Group project. ) S . - Making a paper playground sculpture.
© style of Paul Klee Great fire of London scene. Van Gough inspired. Tjapaltjarri
£
e | know how to use different pens e | know how to use shapes to e | know how to use a combination e | know the difference between e | know the difference between e | know which joining techniques
and pressures to draw lines of create texture. of materials that are cut, torn and thick and thin brushes. thick and thin brushes. to use to join different media and
different sizes and thickness. e | know how to overlay materials. glued. e | know how to Mix primary e | know how to mix primary materials.
o | ® |know how to make pattern and e | know that techniques such as e | know that mixing materials colours to make secondary. colours to make secondary. e | know when to use scissors and
'éo texture by adding dots and lines. rolling, cutting, moulding and creates texture. e | know what primary colours are. e | know what primary colours are. when to use hole punches to
= e | know how to make different carving can be used with clay. e | know how to use a wide range e | know what secondary colours e | know what secondary colours make slots and holes.
é tones with coloured pencils. of tools to create different are. are. e | can draw on previous
v e | know who Paul Klee is textures, lines, tones, colours and e | know that adding white to e | know that adding white to knowledge of 3D sculptures.
2 | e |canidentify key features of Paul shapes. colours can make tints and black colours to make tints and blackto | ® |know that moving parts can be
g Klees work. e | know about and can describe to colours can make tones. colours makes tones. used within 3D sculptures.
2 the work of notable artists, e | know how to make colour e | know how to make colour
[7,]

artisans and designers.
e | know some of the ideas which
artists studied to create pieces.

wheels.

wheels.

e | know that different methods of
painting and printing gives
texture.




Disciplinary Knowledge (Skills)

e Respond to ideas and starting
points.

e Explore ideas and collect visual
information.

e Explore different methods and
materials as ideas develop.

Drawing

o Draw lines of different sizes and
thickness.

e Colour (own work) neatly following
the lines.

e Show pattern and texture by
adding dots and lines.

e Show different tones by using
coloured pencils.

Digital Media

e Use a wide range of tools to create
different textures, lines, tones,
colours and shapes.

e Describe the work of notable
artists, artisans and designers.

e Use some of the ideas of artists
studied to create pieces.

e Respond to ideas and starting
points.

e Explore ideas and collect visual
information.

e Explore different methods and
materials as ideas develop.

Collage

e Use a combination of materials
that are cut, torn and glued.

e Sort and arrange materials.

e Mix materials to create texture.

Sculpture

e Use a combination of shapes.

Include lines and texture.

Use rolled up paper, straws, paper,

card and clay as materials.

Use techniques such as rolling,

cutting, moulding and carving.

Drawing

e Draw lines of different sizes and
thickness.

e Colour (own work) neatly following
the lines.

e Show pattern and texture by
adding dots and lines.

e Show different tones by using
coloured pencils.

Digital Media

e Use a wide range of tools to create
different textures, lines, tones,
colours and shapes.

e Describe the work of notable
artists, artisans and designers.

e Use some of the ideas of artists
studied to create pieces.

e Respond to ideas and starting
points.

e Explore ideas and collect visual
information.

e Explore different methods and
materials as ideas develop.

Painting

e Use thick and thin brushes.

e Mix primary colours to make
secondary.

e Add white to colours to make tints
and black to colours to make tones.

e Create colour wheels.

Collage

e Use a combination of materials
that are cut, torn and glued.

e Sort and arrange materials.

e Mix materials to create texture.

Sculpture

e Use a combination of shapes.

Include lines and texture.

Use rolled up paper, straws, paper,

card and clay as materials.

Use techniques such as rolling,

cutting, moulding and carving.

Drawing

e Draw lines of different sizes and
thickness.

e Colour (own work) neatly following
the lines.

e Show pattern and texture by
adding dots and lines.

e Show different tones by using
coloured pencils.

Digital Media

e Use a wide range of tools to create
different textures, lines, tones,
colours and shapes.

e Describe the work of notable
artists, artisans and designers.

e Use some of the ideas of artists
studied to create pieces.

e Respond to ideas and starting
points.

e Explore ideas and collect visual
information.

e Explore different methods and
materials as ideas develop.

Painting

e Use thick and thin brushes.

e Mix primary colours to make
secondary.

e Add white to colours to make tints

and black to colours to make tones.

e Create colour wheels.

Drawing

e Draw lines of different sizes and
thickness.

e Colour (own work) neatly following
the lines.

e Show pattern and texture by
adding dots and lines.

e Show different tones by using
coloured pencils.

Digital Media

e Use a wide range of tools to create
different textures, lines, tones,
colours and shapes.

e Describe the work of notable
artists, artisans and designers.

e Use some of the ideas of artists
studied to create pieces.

e Respond to ideas and starting
points.

e Explore ideas and collect visual
information.

e Explore different methods and
materials as ideas develop.

Painting

e Use thick and thin brushes.

e Mix primary colours to make
secondary.

e Add white to colours to make tints

and black to colours to make tones.

e Create colour wheels.

Drawing

e Draw lines of different sizes and
thickness.

e Colour (own work) neatly following
the lines.

e Show pattern and texture by
adding dots and lines.

e Show different tones by using
coloured pencils.

Print

e Use repeating or overlapping
shapes.

e Mimic print from the environment
(e.g. wallpapers).

e Use objects to create prints (e.g.
fruit, vegetables or sponges).

e Press, roll, rub and stamp to make
prints.

Digital Media

e Use a wide range of tools to create
different textures, lines, tones,
colours and shapes.

e Describe the work of notable
artists, artisans and designers.

e Use some of the ideas of artists
studied to create pieces.

e Respond to ideas and starting
points.

e Explore ideas and collect visual
information.

e Explore different methods and
materials as ideas develop.

Collage

e Use a combination of materials
that are cut, torn and glued.

e Sort and arrange materials.

o Mix materials to create texture.

Sculpture

e Use a combination of shapes.

o Include lines and texture.

o Use rolled up paper, straws, paper,
card and clay as materials.

e Use techniques such as rolling,
cutting, moulding and carving.

Drawing

e Draw lines of different sizes and
thickness.

e Colour (own work) neatly following
the lines.

e Show pattern and texture by
adding dots and lines.

e Show different tones by using
coloured pencils.

Vocabulary

Light, dark, shade, texture,
movement, sketch.

Texture, pattern, tone, shape,
position.

Light, dark, combination, mood,
bright, hot and cold colours.

Primary and secondary colours, thick,
thin, stroke,

Primary and secondary colours, dots,
dabs, dashes, hashes, symbols, cave,
Aboriginal.

Construct, design, plan, map, scale,




LKS2 Knowledge and Vocab Summary

Pastels — Cave Paintings

Printing — Mountain
scenes

Sketching — Sketches of
Lotherton Hall

British Artist Study —
Hockney Digital Art

Painting - Watercolour

Collage — Pop Art

Drawing — Charcoal Iron Man Portraits

to create sketch books
to record their
observations and use
them to review and
revisit ideas

to improve their
mastery of art and
design techniques,

to create sketch books
to record their
observations and use
them to review and
revisit ideas

to improve their
mastery of art and
design techniques,

to create sketch books to
record their observations
and use them to review
and revisit ideas

to improve their mastery of
art and design techniques,
including drawing, painting
and sculpture with a range

e to create sketch books
to record their
observations and use
them to review and
revisit ideas

e toimprove their mastery
of art and design
techniques, including

to create sketch books to
record their observations
and use them to review and
revisit ideas

to improve their mastery of
art and design techniques,
including drawing, painting
and sculpture with a range

e to create sketch books to record their
observations and use them to review
and revisit ideas

e toimprove their mastery of art and
design techniques, including drawing,
painting and sculpture with a range
of materials [for example, pencil,
charcoal, paint, clay]

e to create sketch books to record their
observations and use them to review
and revisit ideas

e toimprove their mastery of art and
design techniques, including drawing,
painting and sculpture with a range of
materials [for example, pencil, charcoal,
paint, clay]

‘2’ including drawing, including drawing, of materials [for example, drawing, painting and of materials [for example, e about great artists, architects and e about great artists, architects and

painting and sculpture painting and sculpture pencil, charcoal, paint, clay] sculpture with a range of pencil, charcoal, paint, clay] designers in history designers in history

with a range of with a range of materials about great artists, materials [for example, about great artists,

materials [for example, [for example, pencil, architects and designers in pencil, charcoal, paint, architects and designers in

pencil, charcoal, paint, charcoal, paint, clay] history clay] history

clay] e about great artists, e about great artists,

about great artists, architects and designers architects and designers

architects and designers in history in history

in history

= : Famous Artist: Margret T :
Famous Artist (National): Godfre g Famous Artist (International): Romero
» Visual Language David Hockney o Britto Local Artist: Chris Mould
n . . » Process » Process » Process . .
2 » Media & Materials . . » Process . » Emotions » Visual Language
c » Techniques » Techniques . » Techniques ) .
Q > Effects » Techniques » Techniques » Techniques
- ) » Effects » Effects » Colour Theory . .
» Styles & Periods > Effects . . > Effects » Artists and Artisans
. . > Artists and Artisans ) )
> Artists & Artisans > Artists & Artisans
Create scenes using paint
)] o o . .
9 . on iPads in the style of Watercolour painting of a . - .
& . A monochrome printed A pop art picture of Brazilian animals or .
> Cave art using pastels . P A sketch of Lotherton Hall Hockney. volcano popartp Charcoal Iron Man Portrait
© mountain scene . plants.
= (Workshop at Cartright
Hall)

| know that using e | know how to layer two | know that hardnesses of e | know some of the | know a number of brush e | know how to arrange materials fora | ® | know that different pressure on

different pressures on or more colours. pencils can show line, tone techniques used by techniques using thick and striking effect. charcoal can show shade, tone and

pastels will show shade | e | know how to replicate and texture. Hockney. thin brushes to produce e | know what coiling, overlapping, texture.

and texture. patterns observed in | know how to explain and e | know some of the main shapes, textures, patterns tessellation, mosaic and montage is. e | know that sketches can be annotated

| know how to explain natural or built elaborate ideas by features of Hockney’s and lines. e | know the key features of pop art. to explain and elaborate ideas.

and elaborate ideas by environments. annotating sketches. work. | know how to mix colours. | e | know that Romero Britto is a e | know how to use sketching methods
_igo annotating sketches. e | know what printing | know that | can sketch e | know that art can be | know what primary and famous pop artist. such as hatching and cross hatching to
%’ | know that shading can blocks are and that they lightly so that there is no created digitally. secondary colours are. show tone and texture.
° be used to show light can be made from a need to use a rubber to e | know that some artists | know how to use e | know that smudging can show shade,
v and shadow. range of materials. correct mistakes. use digital media. watercolour paint to tone and texture.
,g | know sketching e | know that there are | know that shading can produce washes for
e
£ methods such as artists which use show light and shadow. backgrounds then detail
g hatching and cross printing to create their | know sketching methods can be added.
a hatching can be used to art. such as hatching and cross | know that colour can show

show tone and texture.
| know that pastels can
be smudged to create
texture and shade.

hatching can be used to
show tone and texture.

| know that there are artists
which use sketching as
their main media.

emotions.
| know some features of
Margret Godfreys work.




Disciplinary Knowledge (Skills)

o Develop ideas from
starting points
throughout the
curriculum.

e Collect information,
sketches and resources.

e Adapt and refine ideas
as they progress.

e Exploreideasina
variety of ways.

e Comment on artworks
using visual language.

Drawing

o Use different
hardnesses of pencils to
show line, tone and
texture.

e Annotate sketches to
explain and elaborate
ideas.

e Sketch lightly (no need
to use a rubber to
correct mistakes).

e Use shading to show
light and shadow.

e Use hatching and cross
hatching to show tone
and texture.

Develop ideas from
starting points
throughout the
curriculum.

Collect information,

sketches and resources.

Adapt and refine ideas

as they progress.

Explore ideas in a variety

of ways.

e Comment on artworks
using visual language.

Print

e Use layers of two or
more colours.

e Replicate patterns
observed in natural or
built environments.

e Make printing blocks
(e.g. from coiled string
glued to a block).

e Make precise repeating
patterns.

Digital Media

e Create images, video
and sound recordings
and explain why they
were created.

e Replicate some of the
techniques used by
notable artists, artisans
and designers.

e Create original pieces

that are influenced by

studies of others.

Develop ideas from starting
points throughout the
curriculum.

Collect information,
sketches and resources.
Adapt and refine ideas as
they progress.

Explore ideas in a variety of
ways.

Comment on artworks
using visual language.

Drawing

Use different hardnesses of
pencils to show line, tone
and texture.

Annotate sketches to
explain and elaborate
ideas.

Sketch lightly (no need to
use a rubber to correct
mistakes).

Use shading to show light
and shadow.

Use hatching and cross
hatching to show tone and
texture.

e Develop ideas from
starting points
throughout the
curriculum.

e Collect information,
sketches and resources.

e Adapt and refine ideas
as they progress.

e Exploreideasin a variety
of ways.

e Comment on artworks
using visual language.

Digital Media

e Create images, video
and sound recordings
and explain why they
were created.

e Replicate some of the
techniques used by
notable artists, artisans
and designers.

e Create original pieces
that are influenced by
studies of others.

Develop ideas from starting
points throughout the
curriculum.

Collect information,
sketches and resources.
Adapt and refine ideas as
they progress.

Explore ideas in a variety of
ways.

Comment on artworks
using visual language.

Painting

Use a number of brush
techniques using thick and
thin brushes to produce
shapes, textures, patterns
and lines.

Mix colours effectively.
Use watercolour paint to
produce washes for
backgrounds then add
detail.

Experiment with creating
mood with colour.
Collage

Select and arrange
materials for a striking
effect.

Ensure work is precise.
Use coiling, overlapping,
tessellation, mosaic and
montage.

Drawing

Use different hardnesses of
pencils to show line, tone
and texture.

Annotate sketches to

explain and elaborate ideas.

Sketch lightly (no need to
use a rubber to correct
mistakes).

Use shading to show light
and shadow.

Use hatching and cross
hatching to show tone and
texture.

e Develop ideas from starting points
throughout the curriculum.

e Collect information, sketches and
resources.

e Adapt and refine ideas as they
progress.

e Explore ideas in a variety of ways.

e Comment on artworks using visual
language.

Drawing

e Use different hardnesses of pencils to
show line, tone and texture.

e Annotate sketches to explain and
elaborate ideas.

e Sketch lightly (no need to use a
rubber to correct mistakes).

e Use shading to show light and
shadow.

e Use hatching and cross hatching to
show tone and texture.

Digital Media

e Create images, video and sound
recordings and explain why they
were created.

e Replicate some of the techniques
used by notable artists, artisans and
designers.

e Create original pieces that are
influenced by studies of others.

Develop ideas from starting points
throughout the curriculum.

Collect information, sketches and
resources.

Adapt and refine ideas as they progress.
Explore ideas in a variety of ways.
Comment on artworks using visual
language.

Drawing

Use different hardnesses of pencils to
show line, tone and texture.

Annotate sketches to explain and
elaborate ideas.

Sketch lightly (no need to use a rubber
to correct mistakes).

Use shading to show light and shadow.
Use hatching and cross hatching to
show tone and texture.

influenced by studies of others.

Vocabulary

Pastels, smudge, smear,
blend, combine, fade,

Carve, print, printing block,
ink, layers,

Sketch, cross hatch, fade,
blend, features, HB

Digital, paint, programme,
stylus, ipad,

Watercolour, palette, brush,
mix, pigment

Materials, texture, rip, cut, glue, pop
art,

Smudge, smear, fade, blend, sketch, light,

heavy, pressure




UKS2 Knowledge and Vocab Summary

Drawing and Sculpture —
Architecture study of Zaha
Hadid

Drawing — Art of Anatomy

Collage — UK Landscapes

Drawing - The Arrival (use of HB
pencils/biros to sketch)
Local Artist: Georgia Brooks

Painting Acrylic paints on canvas inspired by
David Hockney

Clay Sculpture — Ancient Greek Tiles

e to create sketch books to

record their observations and
use them to review and revisit
ideas.

e to improve their mastery of

art and design techniques,

e to create sketch books to record

their observations and use them
to review and revisit ideas.

e toimprove their mastery of art

and design techniques, including
drawing, painting and sculpture

e to create sketch books to record

their observations and use them
to review and revisit ideas.

e toimprove their mastery of art

and design techniques, including
drawing, painting and sculpture

e to create sketch books to

record their observations and
use them to review and revisit
ideas.

e toimprove their mastery of art

and design techniques,

e to create sketch books to record their

observations and use them to review and
revisit ideas.

e to improve their mastery of art and design

techniques, including drawing, painting
and sculpture with a range of materials

e to create sketch books to record their
observations and use them to review
and revisit ideas.

e to improve their mastery of art and
design techniques, including drawing,
painting and sculpture with a range of

9]
2 including drawing, painting with a range of materials [for with a range of materials [for including drawing, painting and [for example, pencil, charcoal, paint, clay] materials [for example, pencil, charcoal,
and sculpture with a range of example, pencil, charcoal, paint, example, pencil, charcoal, paint, sculpture with a range of about great artists, architects and paint, clay]
materials [for example, pencil, clay] clay] materials [for example, pencil, designers in history e about great artists, architects and
charcoal, paint, clay] e about great artists, architects and |e about great artists, architects charcoal, paint, clay] about designers in history.
e about great artists, architects designers in history. and designers in history. great artists, architects and
and designers in history. designers in history.
Famous Arist T z : :
. : : . ; Famous Artist (National): David Hockney » Process
(International/Diverse Artist): . Local Artist: Georgia Brooks . )
0 ) » Visual Language » Process . » Visual Language » Techniques
9 | Zaha Hadid ) . . > Emotions . . )
c » Techniques » Media and Materials . » Media and Materials » Styles and Periods
T} » Process » Techniques
- . . > Effects > Effects . . » Colour Theory
» Media and Materials » Artists & Artisans . .
. . > Artists & Artisans
»> Artists & Artisans
S Recycling sculpt
ecycling sculptures, L . ; ;
2 ycing P o . Recreate sketches from The Acrylic painting on canvas, of Pudsey in the Ancient Greek Tiles
= photographed and modified to Three figures of movement Collage of UK landscape ) .
o . Arrival book style of David Hockney
£ show architecture.
¢ | know that life-like qualities e | know that drawings must show ¢ | know what visual and tactile e | know that shading can be used | e | know | need to sketch (lightly) before ¢ | know that carving and adding shapes
and real-life reflections, shadows, direction of qualities are. to depict movement, perspective, | painting to combine line and colour. makes texture and pattern.
proportions provoke sunlight. ¢ | know what ceramic is. shadows and reflection. ¢ | can name colours observed in the natural ¢ | know that frameworks (such as wire or
o different interpretations. ¢ | know that my choice of e | know how to stick ceramic tiles. | ¢ | know that lines represent or built world. moulds) provide stability and form.
T |l know that carving and adding | techniques can depict movement, e | know how to use grout. movement. | know the qualities of watercolour and ¢ | know that some joining techniques are
= | shapes makes texture and perspective, shadows e | know that different pressures acrylic paints. more appropriate for joining certain types
é pattern. and reflection. on pencils create different shades. | ¢ | know that colours, tones and tints can of materials.
g | | know that frameworks (such e | know how to choose a style of enhance the mood of a piece. ¢ | know what ceramic is.
s |as wire or moulds) provide drawing suitable for the work (e.g. ¢ | know that brush techniques and the
*3 stability and form. realistic or impressionistic). qualities of paint to create texture.
2 | ¢ I know that some joining e | know that lines can represent
[7,]

techniques are more appropriate
for joining certain types of
materials.

movement.




Disciplinary Knowledge (Skills)

¢ Develop and imaginatively
extend ideas from starting points
throughout the curriculum.

¢ Collect information, sketches
and resources and present ideas
imaginatively in a sketch book.
¢ Use the qualities of materials
to enhance ideas.

* Spot the potential in
unexpected results as work
progresses.

e Comment on artworks with a
fluent grasp of visual language.
Sculpture

¢ Show life-like qualities and
real-life

proportions or, if more abstract,
provoke

different interpretations.

¢ Use tools to carve and add
shapes, texture and pattern.

e Combine visual and tactile
qualities.

¢ Use frameworks (such as wire
or moulds) to provide stability
and form.

Drawing

e Use a variety of techniques to
add interesting effects (e.g.
reflections, shadows, direction
of sunlight).

¢ Use a choice of techniques to
depict movement, perspective,
shadows and reflection.

¢ Choose a style of drawing
suitable for the work (e.g.
realistic or impressionistic).

¢ Use lines to represent
movement.

Digital Media

¢ Enhance digital media by
editing (including sound, video,
animation, still images and
installations).

* Develop and imaginatively extend
ideas from starting points
throughout the curriculum.

e Collect information, sketches and
resources and present ideas
imaginatively in a sketch book.

¢ Use the qualities of materials to
enhance ideas.

¢ Spot the potential in unexpected
results as work progresses.

e Comment on artworks with a
fluent grasp of visual language.
Drawing

¢ Use a variety of techniques to
add interesting effects (e.g.
reflections, shadows, direction of
sunlight).

¢ Use a choice of techniques to
depict movement, perspective,
shadows and reflection.

¢ Choose a style of drawing suitable
for the work (e.g. realistic or
impressionistic).

¢ Use lines to represent movement.
Textiles

e Show precision in techniques.

¢ Choose from a range of

stitching techniques.

e Combine previously learned
techniques to create pieces.
Digital Media

¢ Enhance digital media by

editing (including sound, video,
animation, still images and
installations).

* Develop and imaginatively extend
ideas from starting points
throughout the curriculum.

e Collect information, sketches and
resources and present ideas
imaginatively in a sketch book.

¢ Use the qualities of materials to
enhance ideas.

¢ Spot the potential in unexpected
results as work progresses.

e Comment on artworks with a
fluent grasp of visual language.
Collage

¢ Mix textures (rough and smooth,
plain and patterned).

e Combine visual and tactile
qualities.

e Use ceramic mosaic materials and
techniques.

Digital Media

¢ Enhance digital media by

editing (including sound, video,
animation, still images and
installations).

* Develop and imaginatively
extend ideas from starting points
throughout the curriculum.

e Collect information, sketches
and resources and present ideas
imaginatively in a sketch book.

¢ Use the qualities of materials to
enhance ideas.

¢ Spot the potential in unexpected
results as work progresses.

e Comment on artworks with a
fluent grasp of visual language.
Drawing

¢ Use a variety of techniques to
add interesting effects (e.g.
reflections, shadows, direction of
sunlight).

¢ Use a choice of techniques to
depict movement, perspective,
shadows and reflection.

¢ Choose a style of drawing
suitable for the work (e.g. realistic
or impressionistic).

¢ Use lines to represent
movement.

* Develop and imaginatively extend ideas
from starting points throughout the
curriculum.

¢ Collect information, sketches and resources
and present ideas imaginatively in a sketch
book.

¢ Use the qualities of materials to enhance
ideas.

¢ Spot the potential in unexpected results as
work progresses.

e Comment on artworks with a fluent grasp
of visual language.

Painting

e Sketch (lightly) before painting to combine
line and colour.

e Create a colour palette based upon colours
observed in the natural or built world.

¢ Use the qualities of watercolour and acrylic
paints to create visually interesting pieces.

e Combine colours, tones and tints to
enhance the mood of a piece.

¢ Use brush techniques and the qualities of
paint to create texture.

¢ Develop a personal style of painting,
drawing upon ideas from other artists.
Drawing

¢ Use a variety of techniques to

add interesting effects (e.g. reflections,
shadows, direction of sunlight).

¢ Use a choice of techniques to

depict movement, perspective, shadows
and reflection.

¢ Choose a style of drawing suitable for

the work (e.g. realistic or impressionistic).

¢ Use lines to represent movement.

Sculpture
¢ Show life-like qualities and real-life

proportions or, if more abstract, provoke

different interpretations.

¢ Use tools to carve and add shapes,
texture and pattern.

e Combine visual and tactile qualities.

¢ Use frameworks (such as wire or moulds)

to provide stability and form.
Drawing

¢ Use a variety of techniques to
add interesting effects (e.g. reflections,
shadows, direction of sunlight).
¢ Use a choice of techniques to

depict movement, perspective, shadows

and reflection.
* Choose a style of drawing suitable for

the work (e.g. realistic or impressionistic).

¢ Use lines to represent movement.

Painting

e Create a colour palette based upon
colours observed in the natural or built
world.

e Use the qualities of acrylic paints to

create visually interesting pieces.

e Combine colours, tones and tints to

enhance the mood of a piece.

¢ Develop a personal style of painting,

drawing upon ideas from other artists and

periods of time.

Vocabulary

Structure, recycling, photography,
shape, form, materials, media

Form, shape, movement, sketch, HB,
crosshatch, pressure

Materials, texture, shape, glue, scale,
perspective

HB pencils, biro, pressure,
perspective, scale.

Acrylic, brush, canvas, texture, thick, thin, primary
colours

Clay, sculpt, carve, imprint, black figure pottery,
protogeometric pottery, geometric pottery,

Corinthian pottery.




Progression of Art & Design Skills

EYFS (Milestone 1)

KS1 (Milestone 2)

LKS2 (Milestone 3)

UKS2 (Milestone 4)

e View a range of different artwork and models.
eShare their creations, explaining the process they have
used.

e Respond to ideas and starting points.
e Explore ideas and collect visual information.
e Explore different methods and materials as ideas

¢ Develop ideas from starting points
throughout the curriculum.
e Collect information, sketches and resources.

¢ Develop and imaginatively extend ideas from starting
points throughout the curriculum.
e Collect information, sketches and resources and

develop. e Adapt and refine ideas as they progress. present ideas imaginatively in a sketch book.
e Explore ideas in a variety of ways. e Use the qualities of materials to enhance ideas.
e Comment on artworks using visual language. * Spot the potential in unexpected results as work
progresses.
e Comment on artworks with a fluent grasp of visual
language.
Painting Painting Painting Painting

e Experiment with colour.
e Use thick and thin brushes.

e Use thick and thin brushes.

* Mix primary colours to make secondary.

¢ Add white to colours to make tints and black to colours
to make tones.

¢ Create colour wheels.

¢ Use a number of brush techniques using thick and thin
brushes to produce shapes, textures, patterns and lines.
¢ Mix colours effectively.

¢ Use watercolour paint to produce washes for
backgrounds then add detail.

¢ Experiment with creating mood with colour.

e Sketch (lightly) before painting to combine line and
colour.

e Create a colour palette based upon colours observed in
the natural or built world.

e Use the qualities of watercolour and acrylic paints to
create visually interesting pieces.

e Combine colours, tones and tints to enhance the mood
of a piece.

e Use brush techniques and the qualities of paint to
create texture.

» Develop a personal style of painting, drawing upon
ideas from other artists.

Collage
e Develop fine motor skills to cut and use scissors.
e Create collages by gluing different media
(sequins, shapes, different types of paper,
natural materials etc.)

Collage

e Use a combination of materials that are cut, torn and
glued.

e Sort and arrange materials.

e Mix materials to create texture.

Collage

e Select and arrange materials for a striking effect.
® Ensure work is precise.

¢ Use coiling, overlapping, tessellation, mosaic and
montage.

Collage

* Mix textures (rough and smooth, plain and patterned).
e Combine visual and tactile qualities.

e Use ceramic mosaic materials and techniques.

Sculpture

e Join different materials (construction, junk
modelling, clay, playdough).

e Safely use techniques that will enhance fine
motor skills: rolling, cutting, pinching, patting,
squeezing.

e Experiment with design, texture, form and
function.

Sculpture

¢ Use a combination of shapes.

e Include lines and texture.

¢ Use rolled up paper, straws, paper, card and clay as
materials.

e Use techniques such as rolling, cutting,

moulding and carving.

Sculpture

¢ Create and combine shapes to create

recognisable forms (e.g. shapes made from nets or solid
materials).

¢ Include texture that conveys feelings,

expression or movement.

¢ Use clay and other mouldable materials.e Add
materials to provide interesting detail.

Sculpture

¢ Show life-like qualities and real-life

proportions or, if more abstract, provoke

different interpretations.

¢ Use tools to carve and add shapes, texture and pattern.
e Combine visual and tactile qualities.

e Use frameworks (such as wire or moulds) to provide
stability and form.

Drawing
e Hold a pencil effectively— using the tripod grip in
almost all cases;
e Use a range of small tools, including scissors,
paint brushes, pencils and markers.
e Begin to show accuracy and care when drawing.
e draw pictures of animals and plants.

Drawing

* Draw lines of different sizes and thickness.

e Colour (own work) neatly following the lines.

e Show pattern and texture by adding dots and lines.
» Show different tones by using coloured pencils.

Drawing

¢ Use different hardnesses of pencils to show line, tone
and texture.

¢ Annotate sketches to explain and elaborate ideas.

e Sketch lightly (no need to use a rubber to correct
mistakes).

¢ Use shading to show light and shadow.

¢ Use hatching and cross hatching to show tone and
texture.

Drawing

¢ Use a variety of techniques to add interesting effects
(e.g. reflections, shadows, direction of sunlight).

¢ Use a choice of techniques to depict movement,
perspective, shadows and reflection.

¢ Choose a style of drawing suitable for the work (e.g.
realistic or impressionistic).

¢ Use lines to represent movement.




Famous

Artists

Print
o Use different equipment for printing (stamps,
sponges, finger prints, natural resources).

Print

e Use repeating or overlapping shapes.

e Mimic print from the environment (e.g. wallpapers).
¢ Use objects to create prints (e.g. fruit, vegetables or
sponges).

® Press, roll, rub and stamp to make prints.

Print

¢ Use layers of two or more colours.

* Replicate patterns observed in natural or

built environments.

e Make printing blocks (e.g. from coiled string glued to a
block).

* Make precise repeating patterns.

Print

¢ Build up layers of colours.

e Create an accurate pattern, showing fine detail.

¢ Use a range of visual elements to reflect the purpose of
the work.

Textiles

e Use weaving to create a pattern.

e Join materials using glue and/or a stitch.
e Use plaiting.

¢ Use dip dye techniques.

Textiles

¢ Shape and stitch materials.

¢ Use basic cross stitch and back stitch.
e Colour fabric.

e Create weavings.

¢ Quilt, pad and gather fabric.

Textiles

e Show precision in techniques.

¢ Choose from a range of stitching techniques.

e Combine previously learned techniques to create
pieces.

Digital Media
e Create images on the interactive whiteboard or a
drawing app.

e Take photographs.

Digital Media
¢ Use a wide range of tools to create different textures,
lines, tones, colours and shapes.

Digital Media
» Create images, video and sound recordings and explain
why they were created.

Digital Media
¢ Enhance digital media by editing (including sound,
video, animation, still images and installations).

e Use some ideas from modelled work to make
your own creation.

¢ Describe the work of notable artists,

artisans and designers.

¢ Use some of the ideas of artists studied to create
pieces.

» Replicate some of the techniques used by notable
artists, artisans and designers.

e Create original pieces that are influenced by studies of
others.

e Give details (including own sketches) about the style of
some notable artists, artisans and designers.

* Show how the work of those studied was influential in
both society and to other artists.

e Create original pieces that show a range of influences
and styles.




